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INTRODUCTION
This guide is intended for system administrators who will use 
RealPlayer Enterprise Configuration Tool 2.1 to customize 
preferences for RealPlayer Enterprise 2.1, Windows Media Player, 
and QuickTime Player.

How This Manual Is Organized
The manual contains the following chapters:

Chapter 1: RealPlayer Enterprise Configuration Tool

This chapter covers the basics of RealPlayer Enterprise Configuration Tool 2.1.

Chapter 2: Setting Player Preferences

This chapter explains how to specify preferences used by RealPlayer Enterprise 
2.1, Windows Media Player, and QuickTime Player.

Chapter 3: Generating Installers

This chapter shows how to generate the RealPlayer Enterprise 2.1 installation 
program.

Conventions Used in This Manual
The following table explains the typographic conventions used in this manual.

Notational Conventions

Convention Meaning

emphasis Bold text is used for in-line headings, user-interface elements, URLs, 
and e-mail addresses.

terminology Italic text is used for technical terms being introduced in a given 
manual or other document, and to lend emphasis to generic English 
words or phrases.

 (Table Page 1 of 2)
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 Introduction
syntax This font is used for fragments or complete lines of programming 
syntax (code or markup languages)—whether within text or set off—
and for command-line instructions.

syntax 
emphasis

Bold syntax character formatting is used for program names and to 
emphasize specific syntax elements.

variables Italic syntax character formatting denotes variables within fragments 
or complete lines of syntax.

[options] Square brackets indicate values you may or may not need to use. As a 
rule, when you use these optional values, you do not include the 
brackets themselves. 

choice 1 
|choice 2

Vertical lines, or “pipes,” separate values you can choose between.

... Ellipses indicate nonessential information omitted from code or 
markup language examples.

Notational Conventions (continued)

Convention Meaning

 (Table Page 2 of 2)
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 Chapter 1: REALPLAYER ENTERPRISE CONFIGURATION TOOL
This chapter provides an overview of RealPlayer Enterprise 
Configuration Tool 2.1. It also explains the differences between the 
current and the previous version of RealPlayer Enterprise Manager.

RealPlayer Enterprise Configuration Tool Overview
RealPlayer Enterprise Configuration Tool 2.1 is a Windows-based tool that 
allows you to customize RealPlayer Enterprise 2.1, Windows Media Player, and 
QuickTime Player with specific preference settings. You can, for example, 
configure players always to use a specific HTTP, RTSP, or MMS proxy server. 

RealPlayer Enterprise Configuration Tool creates one or more customized 
installation programs for Windows. When users within your organization run 
one of these installers on their computers, it does the following:

• Installs a customized version of RealPlayer 10.5, called RealPlayer Enterprise 
2.1. As described in Chapter 2, you can set and lock many of the 
preferences used by RealPlayer Enterprise 2.1.

Tip:  RealPlayer Enterprise 2.1 does not prevent users from 
downloading and installing the free, standard version of 
RealPlayer. Your organization must have its own policies and 
practices to prevent these actions from happening.

• Updates the user’s Windows Registry with selected Windows Media Player 
preferences. These preferences are not locked, however, and the user may 
change them manually.

For More Information:  The section “Updating Windows Media 
Player Preferences” on page 24 explains the preferences that 
you can set.
3



CHAPTER 1: RealPlayer Enterprise Configuration Tool
• Overwrites the user’s QuickTime Player preference file with a new file 
containing preferences that you have chosen. These preferences are not 
locked, however, and the user may change them manually.

For More Information:  The section “Modifying QuickTime 
Player Preferences” on page 30 explains how to set QuickTime 
preferences.

Changes from the Previous Release

RealPlayer Enterprise Configuration Tool 2.1 differs significantly from 
previous versions. It is designed to create RealPlayer Enterprise 2.1 installation 
programs only. Once you have generated your installers, you no longer need to 
run RealPlayer Enterprise Configuration Tool. In contrast, the previous 
version of RealPlayer Enterprise Manager ran as a service that RealPlayer 
periodically contacted for updates. That functionality has been removed.

RealPlayer Enterprise Configuration Tool Requirements

You will need the following components to run RealPlayer Enterprise 
Configuration Tool 2.1 and generate your RealPlayer Enterprise 2.1 installers.

• Windows 2000, XP, Vista Enterprise, or Vista Ultimate

• Internet Explorer browser

The Web-based interface for RealPlayer Enterprise Configuration Tool 
requires Internet Explorer version 5.0 or higher, with support for 
Javascript. 

• RealPlayer Enterprise Configuration Tool 2.1 executable file

RealPlayer Enterprise Configuration Tool is a single executable that you 
can copy to your computer. You do not have to run an installation 
program to set up RealPlayer Enterprise Configuration Tool. Using 
RealPlayer Enterprise Configuration Tool does not affect Windows 
components such as the registry or system tray.

• RealPlayer Executable Programs

You create the customized version of RealPlayer Enterprise 2.1 by 
modifying the RealPlayer product installer file that comes with RealPlayer 
Enterprise Configuration Tool.
4



CHAPTER 1: RealPlayer Enterprise Configuration Tool
Media Player Support
The following table lists the media players that you can install or update on 
various Windows operating systems. Note that only the Windows Vista 
Enterprise and Windows Vista Ultimate editions are supported.

Note the following about media player support:

• RealPlayer Enterprise 2.1

You can use a single installer on all Windows versions even if the installer 
affects another media player. For example, suppose that an installer 
updates preferences for Windows Media Player. If you run the installer on 
Windows 2000, for example, the Windows Media preference changes are 
ignored. The preferences are updated only when you run the installer on 
Windows XP or Vista.

• Windows Media Player

If a computer has a version of Windows Media Player other than the 
supported version (such as Windows Media Player 11 on Windows XP), 
the player’s preference settings are not affected.

• QuickTime Player

If a computer has a version of QuickTime Player other than the supported 
version (such as QuickTime Player 6), the player’s preference settings are 
not affected.

Media Player Installation or Update

Media Player
Windows 
2000 Windows XP

Windows Vista 
Enterprise or Ultimate

RealPlayer Enterprise 2.1 
installation

Yes Yes Yes

Windows Media Player update No player version 10 
only

player version 11 
only

QuickTime Player update No player version 7.0 
(minimum)

player version 7.2 
(minimum)
5
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 Chapter 2: SETTING PLAYER PREFERENCES
This chapter explains how to use RealPlayer Enterprise 
Configuration Tool 2.1 to specify the preferences for RealPlayer 
Enterprise 2.1, Windows Media Player, and QuickTime Player. You 
can then create an installer that installs RealPlayer Enterprise 2.1, as 
well as updates the preferences for Windows Media Player and 
QuickTime Player.

Running RealPlayer Enterprise Configuration Tool
To run RealPlayer Enterprise Configuration Tool 2.1, double-click the 
program executable, RP-Config-Tool.exe. The program launches an HTML-
based interface that utilizes Internet Explorer.

Specifying the Installer File

RealPlayer Enterprise Configuration Tool requests an existing RealPlayer 
installer file when it starts up. RealPlayer Enterprise Configuration Tool uses 
this installer file to create your customized RealPlayer Enterprise 2.1 
installation program. You can enter the full path to this file, or click the 
Browse button to locate this file on your computer. Choose one of the 
following installer files:

• The first time you run RealPlayer Enterprise Configuration Tool, choose 
the version of the RealPlayer installer, playinst_en-enterprise2_1.exe, that is 
included with RealPlayer Enterprise Configuration Tool 2.1. This installer 
is preconfigured with the same default preferences used by the standard 
version of RealPlayer.

Warning!  Do not use a publicly available RealPlayer installer 
downloaded from the Internet.
6



CHAPTER 2: Setting Player Preferences
• Once you have created a RealPlayer Enterprise 2.1 installation file 
according to the instructions in Chapter 3, you can specify that file at 
start-up. This loads into RealPlayer Enterprise Configuration Tool the 
preference settings that you saved into that installation program.

Choosing Preferences

Using the left-hand navigation pane in RealPlayer Enterprise Configuration 
Tool, you can set media player preferences:

• The settings on the Player Preferences pages affect RealPlayer Enterprise 
2.1. The section “Setting RealPlayer Enterprise 2.1 Preferences” on page 9 
explains how to set these preferences.

• The preferences on the Windows Media pages affect Windows Media 
Player. The section “Updating Windows Media Player Preferences” on page 
24 explains how to use these pages.

• The settings on the QuickTime Preferences page affect QuickTime Player. 
The section “Modifying QuickTime Player Preferences” on page 30 
explains how to modify the QuickTime Player preferences file.

• The Player Setup pages allow you to customize additional options for 
RealPlayer Enterprise 2.1, as described in Chapter 3.

When you click a preferences page, such as Internet/Privacy, the preferences for 
that category appear to the right, as shown in the following figure.
7



CHAPTER 2: Setting Player Preferences
RealPlayer Enterprise Configuration Tool Preferences Page

Tip:  Closing the RealPlayer Enterprise Configuration Tool 
browser window resets the preferences you have chosen. After 
you select preferences, be sure to generate a player installer as 
described in Chapter 3 before closing the RealPlayer Enterprise 
Configuration Tool window.

Locking and Unlocking Preferences

You set a preference by entering a value in a text field or selecting an option 
from a pull-down menu. Each preference setting has one of three values:

 Preference value is unlocked. The user can change this value in the media 
player’s preference dialog. Click the icon to lock the preference.

 Preference value is locked. The user cannot change this value in the media 
player’s preference dialog. Click the icon to unlock the preference.

 Preference value cannot be locked. The user can change this value in the 
media player’s preference dialog.
8



CHAPTER 2: Setting Player Preferences
For preference values that can be locked or unlocked, you can set each lock 
individually, or click one of the following options:

• Apply Product Defaults—Reset all values to the default settings used by the 
standard versions of RealPlayer or Windows Media Player.

• Reset Preferences—Reset all values to the settings used in the installation 
program you selected at start-up.

• Lock Section Settings—Lock all options on the current page.

• Unlock Section Settings—Unlock all options on the current page.

Setting RealPlayer Enterprise 2.1 Preferences
The Player Preferences pages set the preference values that will be used by 
RealPlayer Enterprise 2.1.

Player Preferences

The single option on this page globally applies preference settings.

Allow RealPlayer Preferences

For this option, choose one of the following:

• Yes (default)—Include the selected RealPlayer Enterprise 2.1 preferences in 
the RealPlayer Enterprise 2.1 installer.

• No—Do not include the RealPlayer Enterprise 2.1 preferences in the 
installer. In this case, the installer installs the default RealPlayer 
Enterprise 2.1, but also updates the user’s Windows Media Player and 
QuickTime Player preferences, if those options are selected.

Internet/Privacy

Select Yes or No for the options on the Internet/Privacy page to set the basic 
Internet and privacy preferences.

Privacy Settings

The following options affect the kinds of information that RealPlayer 
Enterprise 2.1 exchanges with streaming servers.
9



CHAPTER 2: Setting Player Preferences
Send connection quality data to RealServers

This preference, which is set on by default in the standard RealPlayer, allows 
RealPlayer Enterprise 2.1 to monitor the user’s internet connection during 
data transfer. RealPlayer Enterprise 2.1 can then send connection information 
about bit rates, error rates, and so on back to Helix Server or its proxy server. 
The server stores this information in its access log. If you do not want this 
information to be transmitted, turn this preference off by selecting the No 

value.

For More Information:  For information about RealPlayer 
statistics reporting, refer to the section on client statistics in 
the basic logging chapter of Helix Server Administration Guide.

Send RealPlayer GUID to RealServers

Each RealPlayer Enterprise 2.1 includes a globally unique ID string, such as 
the following:

3ab16eb2-9f30-4c1f-acb6-25dfba5ba0da

In the standard RealPlayer, GUID reporting is turned off by default, but the 
user may turn it on. If GUID reporting is turned off, RealPlayer sends an all-
zero GUID to Helix Server:

00000000-0000-0000-0000-000000000000

You may want to set GUID reporting on if you intend to authenticate user 
access to certain clips on an intranet. Helix Server can the use the GUID to 
validate access to secure content, rather than requiring the user to enter a user 
name and password on each access. To turn on GUID reporting, select the Yes 
value.

For More Information:  For more about using GUIDs to 
authenticate access to secure content, refer to the 
authentication chapter in Helix Server Administration Guide.

Send configuration info when connecting to technical support

This preference is set on by default in the standard RealPlayer. It allows 
RealPlayer Enterprise 2.1 to send configuration information to RealNetworks 
technical support if the user contacts support personnel using the 
Help>Customer Support command. This information is not required to 
process error messages the user has received. 
10



CHAPTER 2: Setting Player Preferences
Enable cookies

In the standard RealPlayer, this preference is set on by default to enable 
RealPlayer to store cookies containing information about streaming media 
sessions. If you want to disable cookies in RealPlayer Enterprise 2.1, select the 
No value.

Enable HTML clip info

Set on by default in the standard RealPlayer, this preference allows RealPlayer 
Enterprise 2.1 to store HTML-formatted information as clip information 
(File>Clip Properties>View Clip Info). If you choose No for this option, clip 
information is stored as simple text.

Allow websites to add items to Now Playing

Set on by default in the standard RealPlayer, this preference allows properly-
programmed Web sites to place clips directly into the “Now Playing” queue 
(View>Now Playing). To turn off this capability for RealPlayer Enterprise 2.1, 
select the No value.

The “Now Playing” pane shows which clips are currently queued to play, and 
which clips have most recently been played. The user can also use it to create 
playlists by dragging and dropping files, links, or clips from the computer's 
file folders or a browser window.

Registered Location

The following options set location information.

Postal Code

For this preference, enter the Zip code where each RealPlayer Enterprise 2.1 is 
located.

Country/Region

For this preference, choose from the pull-down menu the country or region 
where each RealPlayer Enterprise 2.1 is located

Playback

The Playback page contains preference settings that affect clip caching and 
bandwidth use.
11
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Live Pause

The live pause feature allows RealPlayer Enterprise 2.1 to write live broadcast 
streams to a temporary disk cache.

Enable pausing and seeking within live Internet clips

This preference allows RealPlayer Enterprise 2.1 to cache live broadcast 
streams. This lets the user pause the stream, as well as seek through the 
presentation. You can choose one of the following values from the pull-down 
menu to set the amount of data, in minutes, that RealPlayer Enterprise 2.1 can 
cache:

• 0 minutes (pausing and caching disabled)

• 5 minutes

• 10 minutes

• 30 minutes (default value for the standard RealPlayer)

• 1 hour

• 2 hours

• 3 hours

• 6 hours

• 12 hours

Playback resumes if the user pauses the stream longer than the allowed time. 
All of the stream’s cached data is deleted once the user begins to play a new 
stream.

Tip:  Keep in mind that longer pauses require more disk space 
on the user’s computer. The amount of data that can be cached 
is also limited by available disk space. 

Temporarily increase this duration if paused for longer

This option, set on by default in the standard RealPlayer, increases the cache 
size if necessary to provide extended buffering of a paused, live stream.

On-demand Internet Clips

RealPlayer Enterprise 2.1 can write on-demand clips to a temporary disk 
cache. This allows the user to search through the clip without RealPlayer 
Enterprise 2.1 having to re-request portions of the stream from the server.
12



CHAPTER 2: Setting Player Preferences
Cache on-demand streams for faster seeking and smoother playback

Setting this preference to Yes enables RealPlayer Enterprise 2.1 to cache the 
stream for the currently playing clip. The cached data is deleted when the user 
chooses the next clip. The amount of data cached is limited by available disk 
space. This option is set on by default in the standard RealPlayer.

Note:  Cached items can be accessed only by the RealPlayer 
Enterprise 2.1 that handles the cache. Items copied out of the 
cache are unusable.

Pause clip at start

Setting this option to Yes is useful for dial-up connections. It causes RealPlayer 
Enterprise 2.1 to pause the clip until the user manually clicks the Play button. 
This allows RealPlayer Enterprise 2.1 to buffer as much of the clip as possible 
until the viewer is ready to watch it. For broadband connections, the default 
No setting is typically preferred.

Buffered Play

Select the amount of clip time to buffer before playback

This preference specifies the amount of time, in seconds, that RealPlayer 
Enterprise 2.1 may buffer data before playing a clip. Increase this amount 
from the default of 30 seconds to improve playback quality over slower 
connections. This extra buffering occurs only if needed to help ensure 
smoother playback.

Instant Playback

Enable instant playback instead of downloading whenever possible

Set to Yes, this preference enables instant playback for clips that would 
normally be downloaded instead of streamed, such as media clips delivered 
over HTTP. If you keep the default value of No, the entire clip must be 
downloaded before RealPlayer Enterprise 2.1 can play it.

TurboPlay

Enable TurboPlay to reduce loading time for certain streamed connections

Setting this preference to Yes enables the RealPlayer Enterprise 2.1 TurboPlay 
feature. TurboPlay allows RealPlayer Enterprise 2.1 to begin to play an on-
demand clip quickly after the user clicks the link to the clip. This feature 
13



CHAPTER 2: Setting Player Preferences
should be used only with high-speed, broadband connections. It does not 
function with live broadcasts.

TurboPlay makes use of extra network bandwidth to deliver streams faster. For 
example, if a clip is encoded at 256 Kbps per second, RealPlayer Enterprise 2.1 
may initially receive the stream at 512 Kbps to fill its buffer faster. After the 
clip begins to play, the bandwidth use returns to the requested stream speed. 

Note:  Enabling this feature may cause spikes in network 
bandwidth use. However, the spikes tend to be spread out over 
time.

Hardware

The hardware options determine how RealPlayer Enterprise 2.1 uses computer 
resources when decoding and playing media. 

Tip:  Hardware preferences can be left to their default values for 
machines capable of running Windows XP. If your enterprise 
also uses older hardware, leave the preferences unlocked. This 
allows you to change preferences on a case-by-case basis to 
troubleshoot playback problems on older computers.

Playback Performance

The playback performance option primarily affects how RealPlayer Enterprise 
2.1 decodes complex video. 

Select the amount of CPU power that RealPlayer can use to affect playback 
quality

This preference influences the amount of CPU that RealPlayer Enterprise 2.1 
utilizes to render media. The setting primarily affects large, high-speed videos, 
which can require significant processing power to decode. You can select one 
of the following choices:

• Lowest CPU usage

• Slightly more CPU

• Medium quality

• Better quality

• Best quality (default)
14



CHAPTER 2: Setting Player Preferences
For any machine running Windows XP or later, you can leave the preference 
set to the default. For older machines with slower processors, you may want to 
choose a lower value. In this case, RealPlayer Enterprise 2.1 sacrifices some 
video quality to limit its CPU use. The less CPU used to render video, however, 
the more likely the playback will appear choppy and will contain visual 
artifacts.

Enable full-screen video controls

Set to its RealPlayer default value of Yes, this preference allows the user to play 
a video at the screen’s full size. This is not recommended for older machines 
that have slow processors and low amounts of memory for use with graphics.

Sound Card Compatibility

Several preferences affect how RealPlayer Enterprise 2.1 plays audio.

Disable 16-bit sound

If set to Yes (the standard RealPlayer default is No), this preference disables 16-
bit sound (its standard audio output) and causes RealPlayer Enterprise 2.1 to 
use only 8-bit sound. You may want to disable 16-bit sound for computers that 
use older sound cards.

Disable custom sampling rates

The default of No is the preferred setting for computers running Windows XP 
or later. In this case, RealPlayer Enterprise 2.1 upsamples or downsamples all 
audio as necessary to create 16-bit audio output at 44 kHz.

Resampling audio requires a floating point co-processor, which may not be 
present on older computers. If an older machine produces audio at very poor 
quality, set this preference to Yes on that machine. RealPlayer Enterprise 2.1 
then produces sound at the audio file’s native sampling rate.

Disable Direct Sound

Direct Sound is a feature of Windows Direct X. It improves sound quality, but 
uses additional CPU processing power. You may want to set this preference to 
Yes for older computers. The standard RealPlayer default is No.

Playback quality

For audio playback quality, you can choose one of the following options from 
the pull-down menu:
15



CHAPTER 2: Setting Player Preferences
• Content natural rate—RealPlayer Enterprise 2.1 plays all audio at its 
recorded sampling rate. This is recommended for computers with older 
sound cards.

• Automatic upsampling (default)—RealPlayer Enterprise 2.1 upsamples audio 
to 44.1 kHz, which is the sampling rate for audio recorded on CDs. This is 
recommended for newer computers.

• High quality playback—This setting provides highest-quality sound but also 
consumes more CPU than the other options. It requires a sound card 
capable of producing professional-quality audio at 48 kHz. 

Video Card Compatibility

The following preference affects video playback.

Use optimized video

For video playback quality, you can choose one of the following options from 
the pull-down menu:

• Disable optimized video and overlays—Lowest-quality video. Choose only if 
video does not display using the optimized video mode.

• Enable optimized video and disable overlays—Lower-quality video. Choose 
only if video does not display using the optimized video and overlays 
mode.

• Enable optimized video and overlays (default)—Highest-quality video. Use on 
any Windows XP-capable machine.

Network Transports

The network transports affect the use of streaming protocols by RealPlayer 
Enterprise 2.1.

Network Transport

The following preference enables or disables the other network preferences.

Manually configure connections setting

Set this preference to Yes if you want to specify values for the subsequent 
network preferences listed on the Network Transports page. Setting the value 
to No applies the default network transport values.
16



CHAPTER 2: Setting Player Preferences
RTSP Transport

RTSP is the standard control protocol used by Helix Server when streaming 
RealMedia clips and broadcasts to RealPlayer Enterprise 2.1. The RTSP 
Transport options affect stream delivery for RTSP connections. In most cases, 
all of these values can be left to their default settings of Yes.

Note:  The order of the preferences indicates the order in which 
RealPlayer Enterprise 2.1 attempts to receive the stream. For an 
on-demand clip, for example, RealPlayer Enterprise 2.1 
requests RTSP over UDP. If UDP is not available from the 
server, RealPlayer Enterprise 2.1 attempts RTSP over TCP. If 
that option is not available, it tries RTSP cloaked as HTTP, 
using TCP as the transport.

Allow Multicast for live content

If you have a multicast-enabled intranet, you can enable automatic, back-
channel multicasting for live streams from Helix Server. This makes a single, 
multicast stream available to all RealPlayer Enterprise 2.1s, conserving 
network bandwidth. If automatic multicasting is not enabled on Helix Server, 
or this preference is set to No, each RealPlayer Enterprise 2.1 receives a separate 
stream for each live broadcast.

For More Information:  For more on back-channel multicasting, 
refer to the multicasting chapter in Helix Server Administration 
Guide.

Allow UDP for live and on-demand content

User Data Protocol (UDP) is the preferred transport for streaming media. It 
does not incur as much network overhead as TCP, thus allowing for more 
efficient delivery of streaming media. Keep this option set to Yes to indicate a 
preference for UDP for on-demand and non-multicast, live streams.

Warning!  Set this preference to No only if you have a specific 
reason for not using UDP on your network. Doing so may 
significantly raise bandwidth use.

Allow TCP for live and on-demand content

Transmission Control Protocol allows for more reliable delivery of IP packets 
across a network. Because TCP incurs more network overhead than UDP, it is 
less desirable for streaming media than UDP. Leave this preference set to Yes to 
17



CHAPTER 2: Setting Player Preferences
allow RealPlayer Enterprise 2.1 to use TCP if UDP is not allowed on the 
network or not available from a certain server. 

Tip:  You may want to set this preference to No to disallow TCP-
only streams and control bandwidth use more tightly.

Allow HTTP for live and on-demand content

Helix Server uses a feature called HTTP cloaking to deliver RTSP-based streams 
as HTTP. This enables RealPlayer Enterprise 2.1 to circumvent firewalls that 
restrict RTSP communications. The Yes value for this preference allows 
RealPlayer Enterprise 2.1 to receive RTSP content cloaked as HTTP. 

Tip:  If your network uses HTTP only, set the other options to 
No.

PNA Transport

Progressive Networks Audio (PNA) is a proprietary streaming media protocol 
that has been discontinued. RealPlayer Enterprise 2.1 maintains PNA 
compatibility to access content on older servers. In most cases, all of these values 
can be left to their default settings of Yes. 

Tip:  Set all PNA preferences to No to disallow PNA-based 
content.

Allow Multicast for live content

Choose Yes to allow automatic multicasting for live content. See the preceding 
RTSP section for details.

Allow UDP for live and on-demand content

Choose Yes to allow RealPlayer Enterprise 2.1 to use UDP for content. See the 
preceding RTSP section for details.

Allow TCP for live and on-demand content

Choose Yes to allow RealPlayer Enterprise 2.1 to use TCP for content. See the 
preceding RTSP section for details.

Allow HTTP for live and on-demand content

Choose Yes to allow RealPlayer Enterprise 2.1 to use HTTP cloaking for 
content. See the preceding RTSP section for details.
18



CHAPTER 2: Setting Player Preferences
Transport Timeouts

The transport timeout settings specify the amount of time, in milliseconds, 
that RealPlayer Enterprise 2.1 waits for data before attempting the next 
transport. The timeouts apply to both RTSP and PNA streams.

Specify time to wait for Multicast data before attempting the next transport

If RealPlayer Enterprise 2.1 and an origin Helix Server are both enabled for 
multicasting, the player first requests a live broadcast as a back-channel 
multicast. If the specified timeout elapses without a response from the server, 
RealPlayer Enterprise 2.1 requests the broadcast to be delivered in the next 
available transport, which is typically a UDP unicast. The standard timeout 
value used with RealPlayer is 3000 milliseconds.

Specify time to wait for UDP data before attempting the next transport

If RealPlayer Enterprise 2.1 is UDP-enabled, it requests on-demand and non-
multicast content to be delivered using the UDP transport. If the specified 
timeout elapses without a response from the server, RealPlayer Enterprise 2.1 
requests the content to be delivered in the next available transport, which is 
typically TCP. The standard timeout value used with RealPlayer is 4000 
milliseconds.

Specify time to wait for TCP data before attempting the next transport

If RealPlayer Enterprise 2.1 is TCP-enabled, and it requests content to be 
delivered over the TCP transport, it waits the specified timeout time for a 
response from the server. If this time elapses, RealPlayer Enterprise 2.1 
requests the broadcast to be delivered using the next available transport 
(cloaked HTTP). The standard timeout value used with RealPlayer is 4000 
milliseconds.

UDP Ports

RealPlayer Enterprise 2.1 utilizes ports 6970 through 32000 on the user’s 
machine to receive UDP data. The actual data ports used are negotiated with 
the server during stream initialization.

Specify the port(s) RealPlayer will use to receive data

Enter values in this field if you want to set a smaller range of UDP ports for 
RealPlayer Enterprise 2.1. Separate continuous port numbers with a dash, and 
non-continuos port numbers with a comma. For example:

7070,7072,3030-3096
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Proxy

The settings on the Proxy page allow you to set RealPlayer Enterprise 2.1 to 
request content through proxy servers. You can leave this page blank if you are 
not using proxy servers.

PNA and RTSP Proxies

You have several possibilities for specifying RTSP and PNA proxies for use 
with RealPlayer Enterprise 2.1.

Choose the appropriate PNA and RTSP proxy

This preference instructs RealPlayer Enterprise 2.1 on how to connect to PNA-
based or RTSP-based content. Select one of the following options from the 
pull-down menu: 

• No proxy—Do not use a PNA or RTSP proxy. If you choose this option, you 
do not need to enter any other information for RTSP and PNA proxies.

• Use automatic configuration—Do one of the following:

• Use the WPAD protocol rules to search for PAC files on your network. 
These files allow RealPlayer Enterprise 2.1 to connect to one or more 
proxies when requesting content. In this case, you do not need to 
enter any other proxy values.

Note:  RealPlayer Enterprise 2.1 uses PAC files that adhere to 
Network PAC file standards. It does not need a customized 
PAC file format.

• Use a custom script to connect to one or more proxies when 
requesting content. In this case, you must specify the URL to the 
script in the Proxy auto-configuration field. You can leave the other 
proxy values blank.

• Use custom proxies—Use the proxy server values entered in the following 
fields.

Specify a PNA proxy

In this field, enter the DNS name or the IP address of the PNA proxy server. If 
using only an RTSP proxy, you can leave this field blank.
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Specify a PNA port

For the port, enter the PNA port number on the proxy server. This is typically 
port 1090.

Specify an RTSP proxy

In this field, enter the DNS name or the IP address of the RTSP proxy server. If 
using only a PNA proxy, you can leave this field blank.

Specify an RTSP port

For the port, enter the RTSP port number on the RTSP proxy server. This is 
typically port 554.

HTTP Proxy

RealPlayer Enterprise 2.1 can use an HTTP proxy for any content delivered by 
HTTP servers.

Choose the appropriate HTTP proxy

This preference determines how RealPlayer Enterprise 2.1 requests HTTP-
based content. Select one of the following options from the pull-down menu: 

• No HTTP proxy—Do not use an HTTP proxy. If you choose this option, you 
do not need to enter any other information for an HTTP proxy.

• Use system proxy settings—Use the proxy settings of the user’s default 
browser.

• Use automatic configuration—Do one of the following:

• Use the WPAD protocol rules to search for PAC files on your network. 
These files allow RealPlayer Enterprise 2.1 to connect to one or more 
proxies when requesting content. In this case, you do not need to 
enter any other proxy values.

• Use a custom script to connect to one or more proxies when 
requesting content. In this case, you must specify the URL to the 
script in the Proxy auto-configuration field. You can leave the other 
proxy values blank.

• Use custom proxies—Use the proxy server values entered in the following 
fields.

Specify an HTTP proxy

In this field, enter the DNS name or the IP address of the HTTP proxy server.
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Specify an HTTP port

For the port, enter the HTTP port number on the proxy server. This is 
typically port 80.

Proxy Auto-Configuration

If you chose to use a custom script to set any proxy values, enter the full URL 
to the script or scripts in this field. For multiple scripts, separate the values 
with commas or carriage returns. For example:

http://www.example.com/utilities/http_proxies.cgi
http://www.example.com/utilities/rtsp_proxies.cgi

Proxy Exceptions

In this field, you exclude requests to certain host names or IP addresses from 
going through your designated proxy servers. This is useful for eliminating 
the need for a proxy server when RealPlayer Enterprise 2.1 requests content 
from a server inside your firewall. For multiple server exceptions, separate the 
values with commas or carriage returns. For example:

intranet.example.com/
intranetmedia.example.com/

Connection

The Connection page holds bandwidth and timeout preferences.

Bandwidth

Each pull-down menu for the two bandwidth preferences allows you to choose 
one of the following preferred speeds. The default is T1/LAN:

• 28.8 Kbps modem

• 33.6 Kbps modem

• 56.6 Kbps modem

• 64 Kbps ISDN

• 128 Kbps Dual ISDN

• 256 Kbps DSL/Cable

• 384 Kbps DSL/Cable

• 512 Kbps DSL/Cable
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• 768 Kbps DSL/Cable

• T1/LAN

• 10 Mbps LAN

Specify the normal bandwidth for accessing presentations.

The normal bandwidth setting indicates the network bandwidth that 
RealPlayer Enterprise 2.1 normally has available for streaming media. When 
requesting a SureStream clip encoded at multiple bit rates, RealPlayer 
Enterprise 2.1 chooses the encoding that most closely matches, without 
exceeding, its normal bandwidth setting.

Tip:  RealProducer encodes high-bandwidth clips for 
broadband connections at 256 Kbps, 384 Kbps, 512 Kbps, or 
768 Kbps. Surestream clips can contain the same stream 
encoded at many different bit rates.

Specify the maximum bandwidth for accessing presentations.

The maximum bandwidth sets the upper limit at which RealPlayer Enterprise 
2.1 can receive a streaming clip. For example, suppose that RealPlayer 
Enterprise 2.1 has its normal bandwidth set to 256 Kbps and its maximum 
bandwidth set to 512 Kbps. If a SureStream clip is encoded at both 256 Kbps 
and 512 Kbps, RealPlayer Enterprise 2.1 receives the 256 Kbps encoding. If the 
clip is encoded only at 512 Kbps and 768 Kbps, however, it can still receive the 
512 Kbps stream, which does not exceed its maximum bandwidth.

Network Time-out

The timeout values set the number of seconds that RealPlayer Enterprise 2.1 
waits for media delivery.

Specify the amount of time RealPlayer waits before reporting an error when 
connecting to the server

This field sets the number of seconds that RealPlayer Enterprise 2.1 waits for a 
response when requesting a new stream from a server. After this time elapses, 
RealPlayer Enterprise 2.1 reports an error and terminates the request. The default 
value used with RealPlayer is 20 seconds.
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Specify the amount of time RealPlayer waits before reporting an error when 
receiving data from the server

This preference sets the number of seconds that RealPlayer Enterprise 2.1 waits 
for data after the stream has begun. If this time elapses and RealPlayer Enterprise 
2.1 has received no new data packets, RealPlayer Enterprise 2.1 reports an error 
and terminates the stream. The default value used with RealPlayer is 90 seconds.

Online Status

The online status setting determines how RealPlayer Enterprise 2.1 detects the 
user’s network status.

Choose whether RealPlayer should determine the user's online status

From the drop-down menu, choose one of the following values:

• Automatically detect online status

Choose this option if viewers connect through dial-up connections. This 
option allows RealPlayer Enterprise 2.1 to dial the network host number 
automatically when needed.

• Assume the user is online

Use this value for viewers who have broadband connections. If the user is 
not online, the user will have to connect to the network host manually. 
This is the RealPlayer default. 

Updating Windows Media Player Preferences
Optionally, you can use the RealPlayer Enterprise 2.1 installer to update the 
user’s preference settings for Windows Media Player. The installer does this by 
modifying the preference settings stored in the Windows Registry. Note, 
however, that Windows Media Player preferences are not lockable, and the user 
may reset them using the Windows Media Player options dialog.

For More Information:  Refer to the section “Media Player 
Support” on page 5 for information about supported player 
versions and operating systems.

Windows Media Preferences

The single option on this page allows you to enable or disable the setting of 
Windows Media Player preferences.
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Apply Windows Media Preferences

For this option, choose one of the following:

• Yes—Allow the RealPlayer Enterprise 2.1 installer to update the user’s 
Windows Media Player preferences with the values on the Windows Media 
Preferences pages.

• No (default)—Do not allow the RealPlayer Enterprise 2.1 installer to update 
the user’s Windows Media Player preferences. All values on the Windows 
Media Preferences pages are ignored.

Streaming Protocol

The options on the Streaming Protocol page affect how Windows Media Player 
uses network transports and computer ports.

Streaming Protocols

The following options affect the use of network transports. In most cases, you 
can leave these set to their default values of Yes.

Use Multicast protocol to receive streaming media

When set to Yes, this option enables Windows Media Player to receive 
multicasts of live content. If this preference is set to No, each Windows Media 
Player receives a separate stream for each live broadcast.

Use TCP protocol to receive streaming media

When set to Yes, this option enables Windows Media Player to receive 
streaming content using the TCP transport. You may want to set this option 
to No to disallow TCP streams and control bandwidth use more tightly.

Use HTTP protocol to receive streaming media

When set to Yes, this option enables Windows Media Player to receive content 
over HTTP if other streaming transports are not available.

Use UDP protocol to receive streaming media

When set to Yes, this option enables Windows Media Player to receive 
streaming content using the UDP transport. This is the preferred transport 
for streaming media content.
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Warning!  Set this preference to No only if you have a specific 
reason for not using UDP on your network. Doing so may 
significantly raise bandwidth use.

UDP Ports

Here, you can specify a UDP port range. The actual data ports used are 
negotiated with the server during stream initialization.

Specify the port(s) Windows Media Player will use to receive data

Enter values in this field if you want to set a specific range of UDP ports on 
the user’s machine for use by Windows Media Player. You must indicate a 
range of at least eight ports, or nine ports if starting with an odd port number. 
Separate the numbers with a dash. For example:

4020-4040

Streaming Proxy

The Streaming Proxy page allows you to define how Windows Media Player 
uses proxy servers for content delivered using HTTP, MMS, and RTSP.

HTTP Proxy

Windows Media Player can use an HTTP proxy for any content delivered by 
HTTP servers.

Choose the appropriate HTTP proxy

This preference determines how Windows Media Player requests HTTP-based 
content. Select one of the following options from the pull-down menu: 

• No HTTP proxy—Do not use an HTTP proxy. If you choose this option, you 
do not need to enter any other information for an HTTP proxy.

• Use browser’s proxy settings—Use the proxy settings of the user’s default 
browser.

• Use the following proxy server—Use the proxy server values entered in the 
following fields.

• Autodetect proxy settings—Use the WPAD protocol rules to search for PAC 
files on your network. These files allow Windows Media Player to connect 
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to one or more proxies when requesting content. In this case, you do not 
need to enter any other proxy values.

Specify an HTTP proxy

In this field, enter the DNS name or the IP address of the HTTP proxy server.

Specify an HTTP port

For the port, enter the HTTP port number on the proxy server. This is 
typically port 80.

Bypass proxy server for local addresses

Set this option to Yes to eliminate the need for a proxy server when Windows 
Media Player requests content from a server inside your firewall. 

Do not use proxies for the following hosts

In this field, you can exclude requests to certain host names or IP addresses 
from going through your designated proxy server. For multiple server 
exceptions, separate the values with semi-colons or carriage returns. For 
example:

http://www.example.com/
http://www.company.com/

MMS Proxy

Here, you can specify proxies for MMS-based content.

Choose the appropriate MMS proxy

This preference determines how Windows Media Player requests MMS-based 
content. Select one of the following options from the pull-down menu: 

• Do not use a proxy server—Do not use an MMS proxy. If you choose this 
option, you do not need to enter any other information for an MMS 
proxy.

• Use the following proxy server—Use the proxy server values entered in the 
following fields.

• Autodetect proxy settings—Use the WPAD protocol rules to search for PAC 
files on your network. These files allow Windows Media Player to connect 
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to one or more proxies when requesting content. In this case, you do not 
need to enter any other proxy values.

Specify an MMS proxy

In this field, enter the DNS name or the IP address of the MMS proxy server.

Specify an MMS port

For the port, enter the MMS port number on the proxy server. This is typically 
port 1755.

Bypass proxy server for local addresses

Set this option to Yes to eliminate the need for a proxy server when Windows 
media Player requests content from a server inside your firewall. 

Do not use proxies for the following hosts

In this field, you can exclude requests to certain host names or IP addresses 
from going through your designated proxy server. For multiple server 
exceptions, separate the values with semi-colons or carriage returns. For 
example:

www.example.com/
www.company.com/

RTSP Proxy

The following fields define proxies used for RTSP-based content.

Choose the appropriate RTSP proxy

This preference determines how Windows Media Player requests RTSP-based 
content. Select one of the following options from the pull-down menu: 

• Do not use a proxy server—Do not use an RTSP proxy. If you choose this 
option, you do not need to enter any other information for an RTSP 
proxy.

• Use the following proxy server—Use the proxy server values entered in the 
following fields.

• Autodetect proxy settings—Use the WPAD protocol rules to search for PAC 
files on your network. These files allow Windows Media Player to connect 
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to one or more proxies when requesting content. In this case, you do not 
need to enter any other proxy values.

Specify an RTSP proxy

In this field, enter the DNS name or the IP address of the RTSP proxy server.

Specify an RTSP port

For the port, enter the RTSP port number on the proxy server. This is typically 
port 554.

Bypass proxy server for local addresses

Set this option to Yes to eliminate the need for a proxy server when Windows 
media Player requests content from a server inside your firewall. 

Do not use proxies for the following hosts

In this field, you can exclude requests to certain host names or IP addresses 
from going through your designated proxy server. For multiple server 
exceptions, separate the values with semi-colons or carriage returns. For 
example:

www.example.com/
www.company.com/

Performance

The Performance page options affect bandwidth use and buffering for 
Windows Media Player.

Bandwidth

Here you can set Windows Media Player’s upper bandwidth use. When 
requesting a clip encoded at multiple bit rates, Windows Media Player chooses 
the encoding that most closely matches, without exceeding, its bandwidth 
setting.

Specify the maximum bandwidth for accessing presentations 

For this option, you can set the bandwidth that Windows Media player 
considers when requesting content. The recommended setting for Windows 
Media Player is Detect Connection Speed, which allows the player to determine 
the network speed automatically. You can choose one of the following from 
the pull-down menu:
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• Detect Connection Speed

• 28.8 Kbps modem

• 33.6 Kbps modem

• 56.6 Kbps modem

• 64 Kbps ISDN

• 128 Kbps Dual ISDN

• 256 Kbps DSL/Cable

• 384 Kbps DSL/Cable

• 512 Kbps DSL/Cable

• 768 Kbps DSL/Cable

• T1/LAN

Network Buffering

This option affects how long Windows Media Player buffers content.

Specify the amount of time

Set the amount of time, in seconds, that Windows Media Player buffers for 
each piece of content.

Modifying QuickTime Player Preferences
You can bundle a modified QuickTime preference file into the RealPlayer 
Enterprise 2.1 installer. When the user runs the installer, the installer 
overwrites the user’s existing QuickTime preferences file. Because the installer 
does not install the player itself, QuickTime Player 7 must exist on the user’s 
machine when the user runs the RealPlayer Enterprise 2.1 installer.

Note:  The QuickTime preference changes are not locked, and 
the user can later modify them by using the QuickTime 
Player’s preferences dialog.

For More Information:  Refer to the section “Media Player 
Support” on page 5 for information about supported player 
versions and operating systems.
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➤ To include a QuickTime preference file with the RealPlayer Enterprise 2.1 installer:

1. Launch QuickTime Player.

2. Open the QuickTime Player preferences dialog using the command 
Edit>Preferences>QuickTime Preferences.

3. Change the preferences to the values you want to set on each user’s 
machine. 

For More Information:  Refer to the QuickTime Player online 
help for details about the QuickTime preferences.

4. Close the preferences dialog and the QuickTime Player.

5. Determine the full path to the binary preferences file, QuickTime.qtp. The 
following registry key holds the path information on the local computer:

HKEY_LOCAL_MACHINE
    SOFTWARE
        Apple Computer, Inc.
            QuickTime
                LocalUserPreferences
                    FolderPath

6. In RealPlayer Enterprise Configuration Tool, click QuickTime Preferences.

7. For Apply QuickTime Preferences, choose Yes from the pull-down menu.

8. In the field for QT Preference file location, enter the full path and file name 
of the QuickTime preferences file. For example:

C:\Documents and Settings\All Users\Application Data\QuickTime\QuickTime.qtp
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 Chapter 3: GENERATING INSTALLERS
After specifying the preferences for RealPlayer Enterprise 2.1, 
Windows Media Player, and QuickTime Player, you can create the 
RealPlayer Enterprise 2.1 installer. Users run this program to install 
RealPlayer Enterprise 2.1, as well as update their existing Windows 
Media and QuickTime preferences.

Tip:  You can generate any number of RealPlayer Enterprise 2.1 
installers with different preference settings to meet the various 
needs of your users.

Setting RealPlayer Enterprise 2.1 Installation Options
The following sections explain how to generate a RealPlayer Enterprise 2.1 
installation program. To start this process, click Player Setup in RealPlayer 
Enterprise Configuration Tool.

Player Setup

The first set-up field allows you to set the RealPlayer Enterprise 2.1 home 
page.

Home Page

Here, enter an HTTP URL that opens automatically in the RealPlayer 
Enterprise 2.1 browser when RealPlayer Enterprise 2.1 starts up. Leave the 
field blank to specify a blank start-up page. For example:

http://intranet.example.com/index.html
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Favorites Menu

In the fields under Favorites Menu, you can specify the text and URLs for up to 
three media clips that the installer adds to the RealPlayer Enterprise 2.1 
Favorites list. For example:

Help Menu

In the fields under Help Menu, you can specify the text and URLs for three 
HTML pages or media clips that the installer adds to the RealPlayer 
Enterprise 2.1 Help menu.

Installation Options

The Installation Options page contains options that affect how RealPlayer 
Enterprise 2.1 is installed, as well as how it starts up.

Installation Directory

For Installation Directory, specify the folder under the Program Files folder 
where RealPlayer Enterprise 2.1 will be installed. For example, the following 
entry:

Our Enterprise\Media Player

installs RealPlayer Enterprise 2.1 in the following path:

C:\Program Files\Our Enterprise\Media Player

Installation Mode

Under Installation Mode, select one of the following options from the pull-
down menu to set the mode for installation and uninstallation:

• Minimal—A graph shows the progress of the installation or uninstallation. 
The user can abort the process.

• Silent—The user cannot interact with, or abort, the installation or 
uninstallation.

Favorites Menu Text 1 Orientation Video

Favorites URL 1 rtsp://helixserver.example.com/orientation.rm
33



CHAPTER 3: Generating Installers
Startup Mode

For Startup Mode, select one of the following options from the pull-down 
menu:

• Compact—RealPlayer Enterprise 2.1 displays only its media playback pane 
at startup. The browser pane appears when the user chooses to display it, 
or if a requested clip contains a link to an HTML page.

• Full—RealPlayer Enterprise 2.1 displays its media playback pane and 
browser pane at start-up. The home page URL displays in the browser.

Desktop

Under Desktop, select Yes or No for each of the following installation options:

• Shortcut icon for launching RealPlayer Enterprise 2.1 added to the users’ 
desktop.

• RealPlayer Enterprise 2.1 icon added to the Windows Quick Launch 
Toolbar.

• RealPlayer Enterprise 2.1 icon added to the top of the Windows Start 
menu.

Uninstallation Options

The options on the Uninstallation Options page affect the components that are 
removed if the user uninstalls RealPlayer Enterprise 2.1. The user does not 
have the ability to change the options during the uninstallation process. 

If you choose not to remove a certain component, it remains installed on the 
user’s computer and will continue to function if the user reinstalls RealPlayer 
or RealPlayer Enterprise 2.1 in the same folder.

Uninstall database used by RealPlayer to manage your media
This option deletes all data from My Library. The library holds information 
about media clips that the user has acquired and organized. The actual clips 
are not deleted, however.

Uninstall clip and Web Page Favorites
Favorites are media clips or pages that the user has bookmarked using the 
Favorites menu. Choose this option to delete clip and Web page favorites 
during the uninstallation process. 
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Uninstall downloaded Skins files
Skins customize the appearance of the RealPlayer Enterprise 2.1 user 
interface. The user can download new skins using the command View>Choose 
Skin>Get More Skins. Select this option to remove the downloaded skins 
during the uninstallation process.

Uninstall downloaded Visualizations files
Visualizations are animated graphics that display when the user plays an 
audio-only clip. The user can download new visualizations using the 
command View>Choose Visualization>Get More Visualizations. Select this 
option to remove the downloaded visualizations during the uninstallation 
process.

Data Types

On the DataTypes page, you can select which media types RealPlayer 
Enterprise 2.1 plays by default. All media type selections are optional.

Universal Media Player

If you select Yes for Enable Universal Media Player, RealPlayer Enterprise 2.1 
becomes the default application for all media types listed in the following 
table.

Individual Media Types

If you want RealPlayer Enterprise 2.1 to handle only specific media types, 
select No for Enable Universal Media Player. Then enable or disable the handling 
of each media type using the remaining pull-down menus on the DataTypes 
page.

The following table describes the media types that you can choose, and 
provides either a description of the media type, or a listing of the file 
extensions associated with that media type.

Datatype Options

Media Type File Extension or Description

MP3 Audio .mp3

MP3 Audio Playlist .mpu

RealPlayer Legacy Audio CD audio CDs

CD Audio audio CD tracks
 (Table Page 1 of 3)
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RealPlayer Legacy DVD DVDs

WAV Audio .wav

MPEG Video .mpg, .mpeg, .mpv

MPEG Media .mps, .m2v, .m1v, .mvs

MPA Media .mpa

AVI Video .avi

RealText .rt

RealAudio .ra

RealAudio/RealVideo .rm

RealAudio/RealVideo VBR .rmvb

RealPix .rp

RealVideo .rv

Windows Media Audio Track .wma

Windows Media Video File .wmv

Windows Media Audio Shortcut .wax

Windows Media Audio File .asx, .asf

Windows Media Audio/Video File .wm

Windows Media Audio/Video Shortcut .wmx

Windows Media Video Shortcut .wvx

Microsoft Media Server Protocol MMS streaming protocol

QuickTime Movie .mov, .qt

AAC Audio .aac

AAC Audio .m4a

AAC Purchased Audio .m4p

MP2 Audio .mp2

MP1 Audio .mp1

MPEG Audio .mpga

Audio Playlist .pls, .pl

SMIL Multimedia Presentation .smil, .smi

Real-Time Streaming Protocol RTSP streaming protocol

Streaming Media Metafile .ssm

Datatype Options (continued)

Media Type File Extension or Description

 (Table Page 2 of 3)
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Generating the RealPlayer Enterprise 2.1 Installer
When you have set all preferences and installation options, click the Generate 
Player button at the top of the page to create the installation program. 
RealPlayer Enterprise Configuration Tool prompts you to specify a name for 
the RealPlayer Enterprise 2.1 installer, using a .exe extension. For example:

RealPlayerEnterpriseInstaller1.exe

The installation program is created in the same directory where you started 
RealPlayer Enterprise Configuration Tool. You can then distribute the 
installation program or programs to your users. Close RealPlayer Enterprise 
Configuration Tool by clicking the upper-right close button.

Note:  Before installing RealPlayer Enterprise 2.1, users should 
uninstall any versions of RealPlayer or RealPlayer Enterprise 
using Start>Settings>Control Panel>Add or Remove Programs.

Tip:  Quitting RealPlayer Enterprise Configuration Tool resets 
the preferences you have chosen. You can load preferences from 
an installation program you have created by selecting that 
program when starting RealPlayer Enterprise Configuration 

Scalable Multicast .sdp

AU Audio .au

AIFF Audio .aif, .aiff

MIDI Audio .mid, .midi, rmi.

AAC for SD .acp

Liquid Music Track .lqt

Liquid Audio Secure Download .lavs

Liquid Audio File .la

3GPP Content .3gp

AMR Narrow-Band Content .amr

AMR Wide-Band Content .awb

3GPP2 Content .3g2

DivX Video .divx

Datatype Options (continued)

Media Type File Extension or Description

 (Table Page 3 of 3)
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Tool. For details, refer to “Specifying the Installer File” on page 
6.
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